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Запуск AutoCAD 2008

■ Необходимо либо дважды щелкнуть левой 
кнопкой мыши на ярлыке AutoCAD, 
размещенном на Рабочем столе, либо 
выполнить команду Пуск > Программы  > 
Autodesk > AutoCAD 2008 > AutoCAD 2008. 
Начнем знакомство.
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Окно AutoCAD 2008
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Рабочее окно AutoCAD 
2008 



Основные элементы 
интерфейса
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■ Центральная область рабочего окна (по 
умолчанию она черного цвета) 
называется графическим экраном. 

■ Это основная рабочая зона, в которой и 
выполняются все графические 
построения.
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■ Курсор, который перемещается в данной зоне, по 
виду напоминает мишень.

■ Размер перекрестий воображаемой мишени можно 
изменить в настройках или с помощью системной                               
переменной. 

■ Чтобы курсор                                   
гарантированно попал                                           
в нужную точку                                    
графического объекта,                            
существует определенный                       механизм. 
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■ В нижней части графического экрана размещены 
вкладки Model (Модель), Layout1 (Лист1) и Layout2 
(Лист2). 

■ По умолчанию при первом запуске AutoCAD активна 
вкладка Model (Модель). 

■ При щелчке на вкладке Model (Модель) мы 
попадаем в пространство модели (двух- или 
трехмерное представление объекта), а при щелчке 
на вкладке Layout (Лист) переходим в пространство 
листа. 
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■ В левом нижнем углу графического 
экрана отображается пиктограмма осей 
координат. 

■ В AutoCAD, как правило, применяются 
декартовы координаты.
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■ В правой и нижней частях графического 
экрана размещены полосы прокрутки. 

■ Пользуясь ими, можно передвигать 
рисунок по экрану (по умолчанию полосы 
прокрутки не отображаются, поэтому при 
первом запуске программы вы их не 
увидите).
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■ Имеются также еще две полосы 
прокрутки, предназначенные для зоны 
командных строк.

■ В верхней части окна AutoCAD 
расположена строка меню. Под ней 
находятся панели инструментов.
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■ С правой стороны окна размещена 
палитра Dashboard (Инструментальная 
панель), называемая также пультом 
управления или пультом инструментов.

■ В нижней части экрана расположено окно 
командной строки.
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■ Под командной строкой находится панель 
с кнопками, которые отвечают за режимы 
рисования. 

■ Слева от этой панели расположен 
счетчик координат. 
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■ В правой части строки состояния 
находится область, называющаяся 
лотком состояния. 

■ Здесь расположены значки, которые 
служат для индикации различных 
параметров программы и управления 
ими.
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Настройка цвета фона 
рабочего окна

■ В меню Tools 
(Сервис) выберите 
пункт Options 
(Параметры). 

■ Откроется 
диалоговое окно, в 
котором нужно 
перейти на вкладку 
Display (Экран). 
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■ Вкладка Display 
(Экран) содержит 
шесть областей. 

■ В области Window 
Elements (Элементы 
окна) щелкните на 
кнопке Colors 
(Цвета). 

■ Появится диалоговое 
окно Drawing Window 
Colors (Цвета окна 
чертежа). 
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■ В списке Context (Среда) выберите 
пункт 2D model space (Пространство 
двухмерной модели), а в списке 
Interface element (Элемент интерфейса) 
— пункт Uniform background (Общий 
фон). 
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■ Из списка Color (Цвет) выберите нужный 
цвет и выйдите из диалогового окна 
Drawing Window Colors (Цвета окна 
чертежа), нажав кнопку Apply & Close 
(Применить и закрыть). 

■ Теперь закройте диалоговое окно 
Options (Параметры), нажав кнопку OK . 
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Строка меню
■ В последних версиях 

программы в выпадающих 
меню напротив 
большинства пунктов 
появились 
соответствующие значки, 
что определенно 
облегчает работу 
пользователей с 
недостаточно хорошим 
знанием английского 
языка.
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File (Файл)

■ Команды меню File (Файл) позволяют 
создать новый рисунок, новую подшивку, 
открыть ранее созданный чертеж, 
подшивку, установить настройки печати 
и распечатать чертеж. 
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Edit (Правка)

■ Команды меню Edit (Правка) позволяют 
осуществлять стандартные для Windows 
операции работы с буфером обмена 
(вырезать, копировать, вставить), 
выполнять специальные вставки, а также 
производить поиск текста по чертежу.



22

View (Вид)

■ Команды меню View (Вид) позволяют 
управлять отображением объектов на 
экране. 

■ Это меню содержит такие пункты, как 
Zoom (Масштабирование), Pan 
(Панорамирование), Render 
(Тонирование) и т. д.
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■ Отдельно необходимо отметить пункт Clean 
Screen (Чистый экран), действие которого 
дублирует сочетание клавиш Ctrl+0 . 

■ С помощью этого пункта пользователь может 
временно скрыть панели управления и 
заголовок окна AutoCAD, что позволит 
расширить рабочую зону графического экрана.
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Insert (Вставка)

■ Команды меню Insert (Вставка) позволяют 
вставлять в поле чертежа заранее 
созданные блоки и объекты, созданные в 
сторонних приложениях, а также 
импортировать различные файлы.
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Format (Формат)

■ Команды меню Format (Формат) 
позволяют выполнять 
форматирование и 
предварительную настройку 
многих показателей.
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Layer (Слой)

■ Дает возможность пользователю 
управлять слоями и их свойствами.
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Layer States Manager 
(Диспетчер состояний слоев)

■ Функция открывает диалоговое окно, в 
котором вы можете сохранять, 
редактировать (управляя такими 
параметрами, как цвет, вес линии и т. 
д.), переименовывать и удалять 
состояния слоев.
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Layer tools (Инструменты 
слоя)

■ Открывается дополнительное меню, 
которое содержит различные 
инструменты управления слоями.
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Color (Цвет)

■ Устанавливает цвета для новых объектов. 
■ С помощью пункта Linetype (Тип линии) 

можно загрузить и установить типы 
линий, а пункт Lineweight (Вес линии) 
позволяет задать текущий вес линий.
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Scale List (Список 
масштабов)

■ Редактирует наборы масштабов.
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Text Style (Стиль текста) и 
Dimension Style (Размерный 
стиль)

■ Можно создавать, устанавливать и 
изменять текстовые и размерные стили 
соответственно.
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Table Style (Стиль 
таблицы)

■ Задает и изменяет стили таблиц.
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Multileader Style (Стиль 
мультивыноски)

■ Позволяет устанавливать и изменять 
стили мультивыносок — новых объектов, 
появившихся в AutoCAD 2008.
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■ В этом же меню можно выбрать 
соответствующий пункт для установки 
стилей печати — Plot Style (Стиль 
печати), задания режимов отображения 
точек — Point Style (Стиль точки), 
управления стилями мультилиний — 
Multiline Style (Стиль мультилинии).
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Tools (Сервис)
■ Команды меню Tools (Сервис) 

позволяют настраивать саму 
программу, вызывать на 
экран различные 
вспомогательные окна, а 
также загружать внешние 
приложения и управлять 
ими.
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Команды меню Palettes 
(Палитры)

■ Палитра Dashboard (Инструментальная 
панель) содержит контрольные панели с 
кнопками и элементам управления. 

■ С помощью пункта Properties (Свойства) 
пользователь может управлять 
свойствами объектов. 
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Команды меню Palettes 
(Палитры)

■ Воспользовавшись пунктом Tool Palettes 
(Инструментальные палитры), можно вызывать 
на экран и скрывать окно инструментальных 
палитр. 

■ При выборе пункта QuickCalc (Быстрый 
подсчет) открывается палитра инженерного 
калькулятора (ее также можно вызвать 
сочетанием клавиш Ctrl+8 ). 
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Команды меню Palettes 
(Палитры)

■ Пункт Sheet Set Manager (Диспетчер 
подшивок) выводит на экран или 
скрывает диспетчер подшивок. 

■ DesignCenter (Центр управления) 
управляет содержимым рисунков. 
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Command Line 
(Командная строка)

■ Можно убрать с экрана командную 
строку, расположенную в нижней части 
окна программы. Для быстрого вызова 
этой команды можно воспользоваться 
комбинацией клавиш Ctrl+9 .
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Tools (Сервис)

■ Spelling (Орфография), позволяющий 
проверить орфографию в выбранном 
пользователем тексте; 

■ Quick Select (Быстрый выбор) для 
быстрого создания групп объектов; 

■ Draw Order (Порядок следования), 
который предоставляет возможность 
переносить объекты на заданный план.
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Drafting Settings 
(Настройки рисования)

■ Можно устанавливать необходимые 
настройки режимов рисования, а пункт 
Options (Параметры) вызывает 
одноименное диалоговое окно для 
настройки параметров программы.
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Draw (Рисование)
■ Rectangle 

(Прямоугольник), 
■ Helix (Спираль), 
■ Arc (Дуга), 
■ Circle (Круг), 
■ Donut (Кольцо), 
■ Spline (Сплайн), 
■ Ellipse (Эллипс).

■ Line (Отрезок), 
■ Ray (Луч), 
■ Construction Line (Прямая), 
■ Multiline (Мультилиния), 
■ Polyline (Полилиния), 
■ 3D Polyline (3D 

Полилиния), 
■ Polygon (Многоугольник), 
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Modeling 
(Моделирование)

■ Можно создавать различные тела, 
варианты которых представлены здесь 
же: Polysoid, Box (Ящик), Wedge (Клин), 
Cone (Конус), Sphere (Шар), Cylinder 
(Цилиндр), Torus (Тор), Pyramid 
(Пирамида), а используя пункт Wipeout 
(Маскировка) — маскирующие объекты.
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■ В этом же меню присутствуют пункты, 
позволяющие создавать блоки, — Block 
(Блок), таблицы — Table (Таблица), 
точки — Point (Точка), а также вводить 
текст — Text (Текст).
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Hatch (Штрих)

■ Можно использовать штриховку для 
заполнения ею выбранного объекта.
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Boundary (Контур)

■ Команда служит для создания области 
или полилинии из замкнутых объектов.
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Dimension (Размер)
■ Команды меню Dimension (Размер) 

позволяют наносить на поле 
чертежа необходимые размеры, 
выноски, создавать и изменять 
размерные стили. 
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■ С помощью пунктов Linear (Линейный), Aligned 
(Параллельный), Ordinate (Ординатный) и 
Angular (Угловой) можно наносить линейные, 
параллельные, ординатные и угловые размеры 
соответственно.

■ Пункт Arc Length (Длина дуги) служит для 
простановки длины дуги, а Jogged (Ломаный) — 
для нанесения размера с изломом.
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■ Dimension Space (Расстояние между 
размерами) и Dimension Break (Разрыв 
размера), позволяют устанавливать 
расстояние между размерами и 
разрывать размерные линии при 
пересечении.
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■ Пункт Multileader (Мультивыноска) 
позволяет добавлять мультивыноски, 
Inspection (Контроль) — вставлять 
связанную с размером информацию, 
помещенную в рамку, а Jogged Linear 
(Искривленная линия) — искривлять 
размерную линию.
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■ С помощью параметра Oblique 
(Наклонить) можно наклонять выносные 
линии линейных размеров, а пункт 
Dimension Style (Размерный стиль) 
позволяет создавать новые и изменять 
существующие размерные стили.
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Modify 
(Редактирование)

■ Команды меню Modify 
(Редактирование) позволяют 
выполнять простейшие действия 
над объектами: 
масштабирование, обрезку, 
удлинение и многое другое.
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Меню Modify 
(Редактирование) 

■ Erase (Стереть) — позволяет стирать 
объекты чертежа; 

■ Copy (Копировать) — позволяет 
копировать объекты; 

■ Mirror (Зеркало) — создает зеркальные 
отображения объектов; 

■ Offset (Подобие) — с его помощью можно 
создавать подобные объекты; 
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Меню Modify 
(Редактирование)

■ Array (Массив) — позволяет упорядочивать 
много объектов в единую структуру; 

■ Move (Переместить) — перемещает объекты; 
■ Rotate (Повернуть) — позволяет повернуть 

объект вокруг базовой точки; 
■ Scale (Масштабировать) — задает масштаб 

объектов; 
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Меню Modify 
(Редактирование)

■ Stretch (Растянуть) — позволяет растягивать 
объекты; 

■ Lengthen (Увеличить) — увеличивает длину или 
величину центральных углов определенных 
объектов; 

■ Trim (Обрезать) — обрезает объект по 
режущим кромкам; 

■ Extend (Удлинить) — удлиняет объекты до 
кромки другого объекта; 
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Меню Modify 
(Редактирование)

■ Break (Разорвать) — позволяет произвести 
разрыв объекта между двумя точками; 

■ Join (Объединить) — вызывает инструмент, 
позволяющий объединять объекты в форму 
единого, неразбиваемого объекта; 

■ Chamfer (Фаска) — снимает фаски с объектов; 
■ Fillet (Скругление) — округляет кромки объекта. 
■ Change Space (Изменить пространство) — 

позволяет перемещать объекты из пространства 
модели в пространство листа и наоборот. 
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Window (Окно)

■ Позволяет ориентироваться при 
одновременной работе с несколькими 
чертежами и поддерживать 
многодокументный режим работы.

■ Lock Location (Закрепить положение), 
блокирует позицию и размер панелей 
инструментов, а также окон.
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Help (Справка)

■ Меню Help (Справка) содержит разделы, 
помогающие пользоваться справочной 
системой, не прерывая работы с 
основным документом. 
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Панели инструментов

■ По умолчанию под строкой меню 
расположены две панели инструментов. 

■ Они содержат кнопки, каждая из которых 
выполняет определенные функции. 
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Плавающие панели 
инструментов

■ Плавающим панелям инструментов можно 
придавать любую форму путем 
стягивания или растягивания их за углы.
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Standard Annotation 
(Стандартная аннотационная)

■ Содержит кнопки, предназначенные для 
вызова базовых команд: создания (QNew), 
открытия (Open), сохранения (Save) файла, 
просмотра проекта перед печатью (Plot 
Preview) и вывода его на печать (Plot), 
отмены (Undo) и возврата (Redo) действий, а 
также вызова некоторых палитр программы.
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Workspaces (Рабочие 
пространства)

■ Панель инструментов Workspaces (Рабочие 
пространства) содержит раскрывающийся 
список, в котором можно выбирать рабочие 
пространства, настраивать и сохранять их. 

■ Кнопка Workspace Settings (Настройки рабочего 
пространства) открывает диалоговое окно, 
служащее для изменения настроек выбора 
рабочих пространств. 

■ Кнопка My Workspace (Мое рабочее 
пространство) делает текущее рабочее 
пространство используемым по умолчанию.
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Управление панелями 
инструментов

■ Пользователь может отображать и скрывать 
любые панели инструментов. 

■ Для этого нужно воспользоваться пунктом 
меню View > Toolbars (Вид > Панели 
инструментов). 

■ После выбора этого пункта откроется 
диалоговое окно, где следует выбрать панели 
инструментов, которые необходимо отобразить 
или скрыть.
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Добавление кнопок на 
панели инструментов

■ Выполните команду Tools > Customize >  
Interface (Сервис > Настройка > 
Интерфейс) или щелкните правой 
кнопкой мыши на любой панели 
инструментов и выберите пункт 
Customize (Настройка). 
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Добавление кнопок на 
панели инструментов

■ В области Customization in All CUI Files 
(Настройка всех файлов) открывшегося 
окна раскройте список Toolbars (Панели 
инструментов). 
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Добавление кнопок на 
панели инструментов

■ В области Command 
List (Список команд), 
содержащей все 
команды программы, 
выберите команду, 
которую вы хотите 
добавить на панель 
инструментов. 
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Добавление кнопок на 
панели инструментов

■ Для добавления кнопки на 
панель инструментов 
щелкните на ней левой 
кнопкой мыши и, не 
отпуская ее, перетащите в 
список панелей 
инструментов (в область 
Customizations in All CUI 
Files (Настройка всех 
файлов)). 



68

■ Для изменения положения кнопки на 
панели инструментов выберите кнопку в 
области Customizations in All CUI Files 
(Настройка всех файлов) и перетащите 
ее на другую позицию. 
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Удаление кнопок с 
панели инструментов

■ Чтобы удалить кнопку, выберите ее в 
области Customizations in All CUI Files 
(Настройка всех файлов), щелкните на 
ней правой кнопкой мыши и выберите 
команду Remove (Удалить). 
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■ Нажмите кнопку Apply (Применить), 
чтобы сохранить изменения на панелях 
инструментов. 
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Изменение внешнего вида 
кнопок на панелях 
инструментов

■ Выделите нужную кнопку в области 
Customizations in All CUI Files (Настройка всех 
файлов) или Command List (Список команд) 
окна настроек пользовательского интерфейса и 
в области Button Image (Значок кнопки) 
выберите один из предложенных значков.
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Изменение внешнего вида 
кнопок на панелях 
инструментов

■ Нажмите кнопку Edit 
(Правка), чтобы 
нарисовать кнопку 
вручную. Используя 
возможности окна 
Button Editor (Редактор 
кнопок), которое 
открывается при 
нажатии этой кнопки, 
нарисуйте значок.
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Инструменты, настройки и 
кнопки Редактора кнопок 

■ Карандаш — для рисования по клеткам. 
■ Линия — для создания рисунка в виде 

линии. 
■ Круг — для создания рисунка в виде 

круга. 
■ Ластик — для удаления рисунка в 

выбранных клетках. 
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Инструменты, настройки и 
кнопки Редактора кнопок

■ Grid (Сетка) — для отображения клеток 
на рисунке. 

■ Clear (Очистить) — для удаления 
рисунка во всех клетках. 

■ Open (Открыть) — для использования в 
качестве значка любого файла в 
формате BMP, RLE или DIB. 
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Инструменты, настройки и 
кнопки Редактора кнопок

■ Undo (Отменить) — для отмены 
последнего действия. 

■ Save (Сохранить) — для сохранения 
созданного значка. 

■ Save As (Сохранить как) — для 
сохранения созданного значка под 
другим именем. 
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Создание пользовательской 
панели

■ Выполните команду Tools > Customize > 
Interface (Сервис > Настройка > 
Интерфейс) или щелкните правой 
кнопкой мыши на любой панели 
инструментов и выберите пункт 
Customize (Настройка). 
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Создание пользовательской 
панели

■ В области Customizations in 
All CUI Files (Настройка 
всех файлов) 
открывшегося окна 
выберите пункт Toolbars 
(Панели инструментов). 
Щелкните на нем правой 
кнопкой мыши и выберите 
строку New Toolbar (Новая 
панель инструментов). 
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Создание пользовательской 
панели

■ Введите название панели инструментов и 
установите ее основные настройки в области 
Properties (Свойства). 

■ Выберите тип панели: плавающая (Floating), 
размещенная сверху (To p), снизу (Bottom ), 
слева (Left) или справа (Right). 

■ Определитесь, будет ли панель отображаться 
по умолчанию. Введите описание панели в 
поле Description (Описание). 
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Создание пользовательской 
панели

■ В области Command List (Список 
команд) выберите команды, которые вы 
хотите поместить на панель, и добавьте 
их так, как было описано выше. 
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Создание пользовательской 
панели

■ Нажмите кнопку OK, 
чтобы добавить новую 
панель. 
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Пульт 
управления

■ Этот инструмент 
программы AutoCAD, 
представляет собой 
специальную палитру, на 
которой отображаются 
кнопки и элементы 
управления, связанные с 
задачно ориентированным 
рабочим пространством. 
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Layers (Слои)

■ Раскрывающийся список Select a layer 
state (Выбрать состояние слоя) позволяет 
управлять доступными состояниями слоя.
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Layer Isolate 
(Изолирование слоя)

■ Позволяет скрыть или заблокировать все 
слои, кроме тех, которые содержат 
выделенные объекты. 
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Layer Unisolate (Отмена 
изолирования слоя)

■ Позволяет восстанавливать слои, 
изолированные предыдущей командой. 
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Toggle locked layer fading 
(Переключение прозрачности 
заблокированного слоя)

■ Разрешает и запрещает прозрачность 
заблокированных слоев. 
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2D Draw (Двухмерное 
рисование)

■ Кнопки, служащие для создания объектов, 
позволяют строить различные примитивные 
объекты: Line (Отрезок), Construction Line 
(Прямая), Polyline (Полилиния), Polygon 
(Многоугольник), Rectangle (Прямоугольник), 
Arc (Дуга), Circle (Круг), Spline (Сплайн), Ellipse 
(Эллипс), Ellipse Arc (Эллиптическая дуга), а 
также, используя кнопку Revision Cloud 
(Облако), полилинии из дуговых сегментов в 
форме облака.
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■ Здесь же присутствуют кнопки, с 
помощью которых можно вставлять в 
текущий рисунок блоки или другие 
рисунки — Insert Block (Вставка блока), 
создавать блоки — Make Block (Создать 
блок), таблицы — Table (Таблица), 
строить точки — Point (Точка), а также 
создавать многострочный текст — 
Multiline Text (Многострочный текст).
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■ При выборе кнопки Hatch (Штрих) можно 
использовать штриховку для заполнения ею 
выбранного объекта. 

■ Применять заливку позволяет кнопка Gradient 
(Градиент). 

■ С помощью кнопки Region (Область) можно 
преобразовывать объект, ограничивающий 
замкнутое пространство, в объект-область.
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■ Кнопки, предназначенные для редактирования 
объектов, позволяют перемещать их, стирать, 
растягивать и т. д. 

■ Нажав соответствующую кнопку, можно 
осуществить следующие операции: Erase 
(Стереть), Copy (Копировать), Mirror (Зеркало), 
Offset (Подобие), Array (Массив), Move 
(Переместить), Rotate (Повернуть), Scale 
(Масштабировать), Stretch (Растянуть), Trim 
(Обрезать), Extend (Удлинить), Break 
(Разорвать), Chamfer (Фаска), Fillet 
(Скругление) и пр.
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Annotation Scaling 
(Масштабирование 
аннотационных объектов)

■ Позволяет добавлять и удалять текущий 
масштаб аннотационных объектов, а 
также добавлять/удалять существующие.
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Dimensions (Размеры)

■ Раскрывающийся список позволяет 
выбрать, на каком стиле будет основано 
построение размера: аннотационном или 
соответствующем стандарту ISO-25. 
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Text (Текст)

■ Позволяет осуществлять создание, 
редактирование, поиск текста, проверку 
орфографии и другие операции с 
текстовыми объектами.
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Multileaders 
(Мультивыноски)

■ Панель Multileaders (Мультивыноски) служит для 
создания различных выносок и содержит такие 
кнопки, как Multileader (Мультивыноска), Add 
Leader (Добавить выноску), Remove Leader 
(Удалить выноску), Align Multileaders (Выровнять 
мультивыноски). 

■ Кнопка Collect Multileaders (Создать коллекцию 
мультивыносок) позволяет объединить 
мультивыноски в группу.
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Multileaders 
(Мультивыноски)

■ При нажатии кнопки Multilieader Style Manager 
(Диспетчер стилей мультивыноски) на экране 
появляется одноименное окно, позволяющее 
создавать и редактировать стили 
мультивыносок.

■ Кнопка, расположенная в левом верхнем углу 
панели открывает палитру, содержащую 
образцы различных выносок.
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Tables (Таблицы)

■ Содержит кнопки Table (Таблица) и Table 
Style (Стиль таблицы), а также кнопки 
Update Data Links (Обновить связанные 
данные) и Data Link Manager (Диспетчер 
связанных данных), позволяющие 
обновлять данные и создавать связи с 
файлами электронных таблиц программы 
Excel. 
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2D Navigate (Двухмерная 
навигация)

■ Служит для навигации в двухмерном 
пространстве и содержит такие кнопки, 
как Pan Realtime (Панорамирование в 
реальном времени), Realtime 
(Масштабирование в реальном времени), 
Window (Окно) и Extents (Границы).
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■ Команды Customize panel (Настройка 
панели) и Customize commands 
(Настройка команд) открывают 
диалоговое окно Customize User Interface 
(Настройка пользовательского 
интерфейса), с помощью которого  можно 
управлять как содержимым панелей, так 
и свойствами команд, соответствующих 
кнопкам панелей.
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Командная строка

■ В нижней области экрана находится окно 
командной строки. 

■ В этой области отображаются вводимые 
пользователем команды для AutoCAD. 

■ Это все еще один из основных элементов 
интерфейса. 
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■ Командная строка представляет собой средство 
диалога пользователя и программы. 

■ Когда пользователь вызывает команду (из 
главного меню программы либо щелкая на 
соответствующих кнопках панелей 
инструментов), в командной строке 
автоматически отображается название 
вызываемой команды.
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AutoCAD Text Window 
(Текстовое окно AutoCAD)

■ В нем можно вводить 
команды и просматривать 
историю их ввода, при 
этом окно можно 
растягивать и сворачивать 
как обычное приложение 
Windows. 

■ Для закрытия AutoCAD Text 
Window (Текстовое окно 
AutoCAD) достаточно 
повторно нажать клавишу 
F2.
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Динамический ввод
■ Сообщения командной 

строки дублируются 
прямо возле указателя 
мыши. 

■ При построении объектов 
в области указателя 
отображаются 
динамические размеры 
строящегося объекта, 
которые можно здесь же 
и редактировать.
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■ Для вызова списка 
параметров текущей 
команды можно просто 
нажать на клавиатуре 
клавишу _ .
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Строка состояния

■ Внизу окна программы, под областью 
командной строки находится строка 
состояния. 

■ В этой строке размещены кнопки 
режимов рисования и счетчик координат.
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Режимы рисования

■ Кнопки, отвечающие за режимы 
рисования: SNAP (ШАГ), GRID (СЕТКА), 
ORTHO (ОРТО), POLAR (ОТС-ПОЛЯР), 
OSNAP (ПРИВЯЗКА), OTRACK (ОТС-
ОБЪЕКТ), DUCS (ДПСК), DYN (ДИН), LW T 
(ВЕС), MODEL (МОДЕЛЬ) 
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SNAP (ШАГ)

■ Задает параметры шаговой привязки, то 
есть управляет режимом привязки к 
точкам сетки с определенным шагом. 

■ Этой кнопке соответствует 
функциональная клавиша F9 .
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GRID (СЕТКА)

■ Позволяет включать/выключать 
отображаемую сетку из точек. 

■ Этой кнопке соответствует 
функциональная клавиша F7 .
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ORTHO (ОРТО)

■ Включает/выключает специальный режим 
ортогональности (свойство объектов, 
когда касательные к ним в точке 
пересечения перпендикулярны друг 
другу). 

■ Этой кнопке соответствует 
функциональная клавиша F8 .
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POLAR (ОТС-ПОЛЯР)

■ Включает/выключает режим полярного 
отслеживания. 

■ Кнопке POLAR (ОТС-ПОЛЯР) 
соответствует функциональная клавиша 
F10 . 
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OSNAP (ПРИВЯЗКА)

■ Позволяет выбирать определенные точки 
в процессе редактирования рисунка. 

■ Этой кнопке соответствует 
функциональная клавиша F3 .
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OTRACK (ОТС-ОБЪЕКТ)
■ Позволяет включать/выключать режим 

объектного отслеживания, при котором можно 
использовать полярное отслеживание как 
средство обеспечения точности построений от 
промежуточной точки, указываемой с помощью 
объектной привязки. 

■ Этой кнопке соответствует функциональная 
клавиша F11 . 
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DUCS (ДПСК)

■ Включает/отключает режим 
динамических координат при работе с 
трехмерными объектами. 

■ Этой кнопке соответствует 
функциональная клавиша F6 .
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DYN (ДИН)

■ Обозначает динамический ввод. 
■ Она предназначена для включения 

режима дублирования информации, 
выводимой в командной строке, в области 
курсора. 

■ Этой кнопке соответствует 
функциональная клавиша F12 .
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LWT (ВЕС)

■ Включает/выключает режим отображения 
линий в соответствии с их весом. 

■ Веса линий могут отображаться на экране 
или же быть видны только при печати. 

■ Для отображения их на экране нужно 
включить кнопку LWT (ВЕС). 
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MODEL (МОДЕЛЬ)

■ Позволяет переключаться между 
пространствами модели и листа.
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Счетчик координат

■ Он предназначен для отображения 
текущих координат указателя мыши, 
находящегося в области графического 
экрана, и служит для ориентации в поле 
чертежа. 

■ Включить/выключить счетчик можно, 
щелкнув на нем кнопкой мыши.
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Annotation Scale (Масштаб 
аннотационных объектов)

■ Меню Annotation Scale (Масштаб 
аннотационных объектов) позволяет 
установить текущее значение масштаба 
аннотаций. 

■ Любые аннотационные объекты, 
добавляемые на чертеж, будут 
отображаться в масштабе, 
соответствующем указанному значению.
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Annotation Visibility 
(Отображение аннотации)

■ Изменяет значение системной 
переменной ANNOALLVISIBLE. 
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■ Следующая кнопка изменяет значение 
системной переменной 
ANNOAUTOSCALE, которая управляет 
автоматическим масштабированием. 
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Закрепление на экране палитр 
и панелей инструментов

■ Кнопка Toolbar/Window Positions Unlocked/Locked 
(Расположение панелей инструментов/окон    
незакреплено/Закреплено). 

■ В зависимости от своего состояния эта кнопка 
имеет вид открытого или закрытого замка. 
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Очистка экрана

■ Кнопка очистки экрана — Clean Screen 
(Очистить экран). 

■ Вызов данной команды из строки 
состояния ничем не отличается от 
запуска ее с помощью меню или 
использования сочетания клавиш Ctrl+0 .
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Контекстные меню

■ Контекстное меню — это меню, которое 
вызывается щелчком правой кнопкой 
мыши при нахождении указателя над 
каким-либо объектом интерфейса или 
при выполнении команды во время 
построения примитивов. 
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■ Если при построении какого-либо 
объекта возникает необходимость 
привязки, достаточно, удерживая 
клавишу Shift, щелкнуть правой 
кнопкой мыши на графической 
области экрана. 

■ При этом рядом с указателем мыши 
появится контекстное меню, 
содержащее все варианты привязки. 

■ Достаточно выбрать нужный и 
продолжить работу.
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Работа с файлами

■ Все чертежи в системе AutoCAD 
представляют собой файлы, имеющие 
расширение DWG. 

■ В одном таком файле программа 
сохраняет всю содержащуюся на 
чертеже информацию: сам чертеж, 
всевозможные стили, блоки и массу 
других сведений.
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Создание чертежа
■ Для формирования 

чертежа необходимо 
выполнить команду File > 
New (Файл > Создать). 

■ После этого действия 
откроется диалоговое 
окно Create New Drawing 
(Создание нового 
чертежа).
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Open a Drawing 
(Открытие чертежа)

■ Вызывает диалоговое окно открытия 
файла чертежа, в котором можно 
выбрать созданный ранее чертеж. 
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Start from Scratch 
(Простейший шаблон)

■ С ее помощью можно 
создать простейший 
шаблон. Необходимо 
указать всего один 
параметр — в каких 
единицах измерения 
будет производиться 
построение: Imperial 
(Британские) или Metric 
(Метрические).
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Use a Template 
(Использовать шаблон) 

■ Создание чертежа 
по заранее 
подготовленному 
шаблону. 
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Use a Wizard 
(Использовать мастер) 

■ Дает возможность быстро установить 
настройки будущего чертежа и приступить 
к работе.
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Мастер Advanced Setup 
(Расширенная установка) 

■ Указываем единицы 
измерения для 
построения чертежа 
и точность единиц 
измерения 
(количество знаков 
после точки).
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■ Выбираем тип 
используемых угловых 
единиц: Decimal Degrees 
(Десятичные градусы), 
Deg/Min/Sec 
(Град/Мин/Сек), Grads 
(Грады), Radians 
(Радианы) или Surveyor 
(Топографические) — и 
их точность.
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■ Далее — выбираем направление для 
нулевого угла.

■ В следующем окне задаем направление 
отсчета углов: Counter-Clockwise (Против 
часовой стрелки) или Clockwise (По 
часовой стрелке).
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■ Устанавливаем 
размеры 
области, 
выбранной  для  
рисования.



133

Сохранение чертежа

■ Нажимаем кнопку Save (Сохранить), 
расположенную на панели инструментов 
Standard Annotation (Стандартная 
аннотационная). 

■ Откроется окно, в котором нужно выбрать 
папку для сохранения и ввести имя файла 
чертежа. 
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Завершение работы

■ Для завершения работы программы 
необходимо выполнить команду File > 
Exit (Файл > Выход) или нажать кнопку 
закрытия программы, которая 
расположена в правом верхнем углу окна 
AutoCAD. 

■ Можно также воспользоваться 
сочетанием клавиш Ctrl+Q . 
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Управление экранным 
отображением

■ Панорамирование
■ Полосы прокрутки
■ Масштабирование
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Панорамирование

■ Для использования команды Pan 
(Панорамирование) нажмите кнопку Pan 
Realtime (Панорамирование в реальном 
времени) на панели 2D Navigate (Двухмерная 
навигация) пульта управления, переместите 
указатель в виде ладошки на рабочую 
область, нажмите кнопку мыши и, не 
отпуская ее, перетаскивайте его до тех пор, 
пока на экране не появится необходимая вам 
область.
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Полосы прокрутки

■ Чтобы их вызвать, нужно выполнить 
команду Tools > Options (Сервис 
Параметры), в открывшемся диалоговом 
окне перейти на вкладку Display (Экран) 
и в области Window Elements (Элементы 
окна) установить флажок Display scroll 
bars in drawing window (Отображать 
полосы прокрутки в окне чертежа).
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Масштабирование

■ Для выполнения команды масштабирования 
нажмите кнопку Realtime (Масштабирование 
в реальном времени) на панели 2D Navigate 
(Двухмерная навигация) пульта управления. 

■ Затем щелкните на экране и, не отпуская 
кнопку мыши, перемещайте указатель вверх 
для увеличения масштаба изображения и 
вниз для его уменьшения.
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Zoom 
(Масштабирование)

■ С ее помощью можно выполнить такие 
операции, как масштабирование 
выделенных объектов во весь экран, 
масштабирование всего изображения во 
весь экран, масштабирование по 
выбранной точке и т. д.


